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ビジュアルヘルプ – グラフ（４） 

 

複数の軸を持つグラフの作成 

このセクションでは、特定のプロットの端に複数の軸を接続するグラフの作成方法を説明します。 

例えば： 

 

この例を作成するために、まずいくつかのデータを作成します： 

Make/N=100 wave1,wave2,wave3; SetScale x,0,20,wave1,wave2,wave3 

wave1=sin(x); wave2=5*cos(x); wave3=10*sin(x)*exp(-0.1*x) 

その後、以下の手順を実行します： 

1． New Graph ダイアログ（メニュー Windows→New 

Graph）を使って、次の内容を表示します： 

wave1 vs 組み込みの左軸と組み込みの下軸。 

New Graph ダイアログで、Y Wave(s) リストから 

wave1 を、X Wave リストから _calculated_ を選択し

て、Do It をクリックします。 

 

2． wave2 vs 左側自由軸 L1 と組み込みの下軸。 

Append Traces ダイアログ（メニュー Graph→Append 

Traces to Graph）で、Y Wave(s) リストから wave2 を

選択し、下の Axis から New を、X Wave リストから 

_calculated_ を選択します。 

New Free Axis ダイアログで名前を L1 と入力して、Do It

をクリックします。 
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3． wave3 vs 左側自由軸 L2 と組み込みの下軸。 

Append Traces ダイアログ（メニュー Graph→Append 

Traces to Graph）で、Y Wave(s) リストから wave3 を

選択し、下の Axis から New を、X Wave リストから 

_calculated_ を選択します。 

New Free Axis ダイアログで名前を L2 と入力して、Do It

をクリックします。 

 

4． 現在、グラフは右のようになっています。 

 

5． Modify Graph ダイアログ（メニュー Graph→Modify 

Graph）を使って、左余白を 1.5 インチに設定し、Do It を

クリックします。 

 

6． L1 軸を左軸の左側にドラッグし、L2 軸をさらにその左側にド

ラッグします。 

 

7． Modify Trace Appearance ダイアログを使って、トレース

の破線パターンを設定します。 
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8． 軸ラベルを設定するには、Modify Axis ダイアログの Axis 

Label タブを使います。 

Axis Label タブで、Axis ポップアップメニューから Left 

を選択し、Special ポップアップメニューから Trace 

Symbol を選択し、wave1 を選択します。 

Axis Label エリアの内容が \s(wave1) sin になるように文

字を追加します。 

同様に、L1 軸、L2 軸もセクションの最初の画像のようにな

るようにラベルを作成します。 

 

9． 軸やラベルの位置をドラッグして調整すれば完成です。 

 

 

積み重ねたプロットの作成 

Igor はグラフ内で無制限の数の軸を使用できる機能と、軸の長さを縮小する機能を組み合わせることで、積み重ね

プロットの作成を容易にします。 

プロットのマトリックスを作成することもでき、プロットに挿入されたプロットを作成することもできます。 

積み重ねグラフを作成する別の方法は、サブウィンドウを使

うことです。 

例はヘルプ Guides Mode and Guide Tutorial を参照してく

ださい。 

ページレイアウト内でグラフのサブウィンドウまたはグラフ

レイアウトオブジェクトを使い、重ね合わせたグラフを作成

することも可能です。 

このセクションでは、Igor のグラフの一部のみをプロットす

る機能を使って、１つのグラフウィンドウ内に積み重ねプロ

ット領域を作成します。 

例えば、右のグラフを作成するとします。 

まず、いくつかのデータを作成します： 

 

Make wave1,wave2,wave3,wave4 

SetScale/I x 0,10,wave1,wave2,wave3,wave4 

wave1=sin(2*x); wave2=cos(2*x) 

wave3=cos(2*x)*exp(-0.2*x) 

wave4=sin(2*x)*exp(-0.2*x) 
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その後、以下の手順を実行します： 

1． New Graph ダイアログ（メニュー Windows→New 

Graph）を使って、次の内容を表示します： 

wave1 vs 組み込みの左軸と組み込みの下軸。 

New Graph ダイアログで、Y Wave(s) リストから 

wave1 を、X Wave リストから _calculated_ を選択し

て、Do It をクリックします。 

 

2． wave2 vs 左側自由軸 L2 と組み込みの下軸。 

Append Traces ダイアログ（メニュー Graph→Append 

Traces to Graph）で、Y Wave(s) リストから wave2 を

選択し、下の Axis から New を、X Wave リストから 

_calculated_ を選択します。 

New Free Axis ダイアログで名前を L2 と入力して、Do It

をクリックします。 

 

3． wave3 vs L2 と下側自由軸 B2。 

Append Traces ダイアログ（メニュー Graph→Append 

Traces to Graph）で、Y Wave(s) リストから wave3 を

選択し、下の Axis から L2 を、X Wave リストから 

_calculated_ を選択し、下の Axis から New を選択しま

す。 

New Free Axis ダイアログで名前を B2 と入力して、Do 

It をクリックします。 
 

4． wave4 vs 組み込みの左軸と下側自由軸 B2。 

Append Traces ダイアログ（メニュー Graph→Append 

Traces to Graph）で、Y Wave(s) リストから wave4 を

選択し、下の Axis から Left を、X Wave リストから 

_calculated_ を選択し、下の Axis から B2 を選択しま

す。 
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5． これで、軸とトレースがごちゃ混ぜになったグラフが生成され

ます。 

 

6． Graph→Modify Axis を選択して、Axis タブをクリックし

ます。 

次の４つの手順では、Axis タブの Axis セクションにある

Draw between 設定を使います。 

 

7． Axis ポップアップメニューから left を選択し、左軸を通常

の 0%から 45%の間で描画するように設定します. 

 

8． Axis ポップアップメニューから bottom を選択し、下軸を

通常の 0%から 45%の間で描画するように設定します. 

 

9． Axis ポップアップメニューから L2 を選択し、L2 軸を通常の

55%から 100%の間で描画するように設定します。 

また、Free Position セクションでは、ポップアップメニュ

ーから Distance from Margin を選択し、Distance 設定

を 0 に設定します。 

 

10． Axis ポップアップメニューから B2 を選択し、B2 軸を

通常の 55%から 100%の間で描画するように設定します。 

また、Free Position セクションでは、ポップアップメニュ

ーから Distance from Margin を選択し、距離設定を 0 に

設定します。 

Do It をクリックします。 
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11． 結果、右のようなグラフとなります。 

 

 

ずらした積み重ねプロット 

積み重ねプロットの一般的なバリエーションは次のようなものです： 

 

この例は、前のプロットで使われたウェーブのうち３つから作成されました。 

wave1は左軸と下軸を使ってプロットされ、wave2は右軸と下軸を使い、wave3は左軸と下軸を使いました。 

次に、Modify Axis ダイアログの Axis タブを使って、左軸を通常値の 0%から 33%の範囲で描画するように設定

し、右軸を 33%から 66%の範囲、L2軸を 66%から 100%の範囲で描画するように設定しました。 

下軸に対して、Axis Standoff チェックボックスをオフに設定します。 

他の軸については、縮小範囲で軸が描画される場合、軸スタンドオフは使われないため、これは必要ありません。 

  

Modify Axis ダイアログから戻り、軸の位置を調整し、グラフのサイズを変更し、プロット領域の周囲の枠をプロッ

ト相対座標系のポリゴンを用いて描画すると、目的のグラフになります。 
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ウォーターフォールプロット 

一連のトレースを透視図法で表示するグラフを作成できま

す。 

このタイプのグラフはウォーターフォールプロットと呼ば

れ、NewWaterfall コマンドまたは Windows→New→

Packages→Waterfall Plot を選択して作成、編集できます。 

ウォーターフォールプロットを表示するには、まずマトリッ

クスウェーブを作成または読み込む必要があります（データ

が 1Dウェーブフォームまたは XYペア形式の場合、フェイク

ウォーターフォールプロットを作成する方が容易な場合があ

ります。「フェイクウォーターフォールプロット」のセクシ

ョンを参照してください）。 

この 2D行列では、個々の行列の列がウォーターフォールプ

ロット上で別々のトレースとして表示されます。 

行列ウェーブの各列は、X軸と Z軸で定義される長方形内に

プロットされ、その長方形によって切り取られます。 

このプロット矩形は、右軸である傾斜した Y軸に沿って、Y

値の関数として位置をずらします。  

プロットごとに表示できる行列ウェーブは１つだけです。 

トレースは等間隔でプロットすることができ、その場合、トレースの X座標と Y座標の位置はマトリックスの X方

向および Y方向の次元スケーリングによって決定されます。 

あるいは、別々の 1Dの Xウェーブと Yウェーブによって決定される不均等な間隔でプロットすることも可能です。 

ウォーターフォールプロットの特定のプロパティを変更するには、

ModifyWaterfall コマンドを使う必要があります。 

その他のプロパティについては、通常の軸やトレースのダイアログを使う必

要があります。 

ウォーターフォールプロットのトレースは１つのウェーブから生成するた

め、Modify Trace Appearance ダイアログまたは ModifyGraph コマンド

によるウォーターフォールプロットの外観変更は、すべてのウォーターフォ

ールトレースにグローバルに影響します。 

例えば、ダイアログで色を変更すると、すべてのウォーターフォールトレー

スが同じ色に変わります。  

各トレースに異なる色を割り当てたい場合は、トレースの色を指定するために（f(z)として）個別のウェーブを使う

必要があります。 

この方法の具体例については、次のセクションの例を参照してください。 

ウォーターフォールの X軸と Z軸は常に下部と左側に配置され、Y軸はデフォルトで右側に 45度の角度で配置され

ます。 

Y軸の角度と長さは ModifyWaterfall を使って変更できます。 

隠線表示が有効な場合を除き、トレースは後ろから前に向かって描画されます。 

隠線は、トレースモードが lines between points の場合にのみ有効であることに注意してください。 

マーキーの拡大は、下軸と右（ウォーターフォール）軸のみに基づいています。 

マーキーはボックスとして描画され、底面は ZY平面上の zminに位置し、上面は ZY平面上の zmaxに位置しま

す。 
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カーソルを使用でき、表示パネルは X、Y、Z軸の情報を提供します。 

hcsr 関数と xcsr 関数は他の場合と同じです。 

vcsr 関数は Yデータ値（ウォーターフォール）を返し、zcsr 関数はデータ（Z軸）値を返します。 

 

等間隔ウォーターフォールプロットの例 

この例では、プロット対象の行列の X軸および Y軸スケーリングから得られる等間隔の X値と Y値を用いて、ウォ

ーターフォールプロットを作成します。 

プロシージャウィンドウに次の関数を定義して、コンパイルします。 

Function EvenlySpacedWaterfallPlot() 

 // ウォーターフォールプロット用の行列を作成 

 Make/O/N=(200,30) mat1 

 SetScale x,-3,4,mat1 

 SetScale y,-2,3,mat1 

 mat1=exp(-((x-y)^2+(x+3+y)^2)) 

 mat1=exp(-60*(x-1*y)^2)+exp(-60*(x-0.5*y)^2)+exp(-60*(x-2*y)^2) 

 mat1+=exp(-60*(x+1*y)^2)+exp(-60*(x+2*y)^2) 

 // ウォーターフォールプロットを作成 

 NewWaterfall /W=(21,118,434,510) mat1 

 ModifyWaterfall angle=70, axlen= 0.6, hidden= 3 

 // 色を Zの関数として適用 

 Duplicate mat1,mat1ColorIndex 

 mat1ColorIndex=y 

 ModifyGraph zColor(mat1)={mat1ColorIndex,*,*,Rainbow} 

End 

コマンドラインで次を実行します： 

EvenlySpacedWaterfallPlot() 

 

 

等間隔ではないウォーターフォールプロットの例 

この例では、別々の 1Dウェーブから得られた不均等な間隔の X値と Y値を用いて、ウォーターフォールプロットを

作成します。 

プロシージャウィンドウに次の関数を定義して、コンパイルします。 
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Function UnvenlySpacedWaterfallPlot() 

 // ウォーターフォールプロット用の行列を作成 

 Make/O/N=(200,30) mat2 

 SetScale x,-3,4,mat2  // 生成のためだけにスケーリングが必要 

 SetScale y,-2,3,mat2  // フェイクデータ 

 mat2=exp(-((x-y)^2+(x+3+y)^2)) 

 mat2=exp(-60*(x-1*y)^2)+exp(-60*(x-0.5*y)^2)+exp(-60*(x-2*y)^2) 

 mat2+=exp(-60*(x+1*y)^2)+exp(-60*(x+2*y)^2) 

 SetScale x,0,0,mat2  // ウォーターフォールプロットでは X と Y ウェーブを使うため、 

 SetScale y,0,0,mat2  // スケーリングは不要になる 

 // X と W ウェーブを作成 

 Make/O/N=200 xWave = 10^(p/200) 

 Make/O/N=30 yWave = 10^(p/30) 

 // ウォーターフォールプロットを作成 

 NewWaterfall /W=(21,118,434,510) mat2 vs {xWave,yWave} 

 ModifyWaterfall angle=70, axlen= 0.6, hidden= 3 

 // 色を Zの関数として適用 

 Duplicate mat2,mat2ColorIndex 

 mat2ColorIndex=y 

 ModifyGraph zColor(mat2)={mat2ColorIndex,*,*,Rainbow} 

End 

コマンドラインで次を実行します： 

UnvenlySpacedWaterfallPlot() 

 

 

フェイクウォーターフォールプロット 

本当のウォーターフォールプロットを作成するには 2Dウェーブが必要です。 

データが 1Dウェーブフォームまたは XYペア形式の場合、「フェイクウォーターフォールプロット」を作成する方

が簡便な場合があります。 

フェイクウォーターフォールプロットでは、通常のグラフでウェーブフォームまたは XYデータをプロットした後、

トレースをオフセットすることでウォーターフォール効果を作成します。 

フェイクウォーターフォールプロットは通常の Igor トレースを使うため、通常のグラフと同様に外観をコントロー

ルできます。 

隠線除去後の結果は次のようになります： 
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X方向と Y方向のオフセットがあるため、軸の目盛ラベルは誤解を招く可能性があります。 

Igor には、フェイクウォーターフォールプロットを作成する方法を示すデモエクスペリメントが含まれています： 

File→Example Experiments→Graphing Techniques→Fake Waterfall Plot 

Igor には、本当のウォーターフォールプロットの作成方法を示すデモエクスペリメントも含まれています： 

File→Example Experiments→Visualization→Waterfall 

 

ウィンドバーブプロット 

ウィンドバーブプロットを作成するには、XYプロットを作成し、マーカーにウィンドバーブを使うように Igor に

指示します。 

ModifyGraph arrowMarker を使ってマーカーをウィンドバーブに変換します。 

各ポイントにおけるバーブの長さ、角度、数を指定するウェーブをこの関数に渡します。 

ウィンドバーブを色分けしたい場合は、ModifyGraph zColor を使って f(z) モードで色を有効にし、各ポイントの

色を指定するウェーブを渡します。 

以下に例を示します。 

各セクションごとにコマンドを実行し、動作を確認してください。 

// XYデータを作成 

Make/O xData = {1, 2, 3}, yData = {1, 2, 3} 

Display yData vs xData   // グラフを作成 

ModifyGraph mode(yData) = 3  // マーカーのモード 

 

// 各ポイントにおけるバーブの長さ、角度、 

// 数をコントロールするバーブデータウェーブを作成する 

// バーブ数をコントロールするには、 

// 列 2の列ラベルを WindBarbに設定する必要がある 

// バーブの長さ、角度、数をコントロール 

Make/O/N=(3,3) barbData 

// 列ラベルを WindBarbに設定 

SetDimLabel 1, 2, WindBarb, barbData 

Edit /W=(439,47,820,240) barbData 
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// barbDataにデータを投入 

// 列 0: バーブの長さ（ポイント） 

barbData[0][0]= {20,25,30} 

// 列 1: バーブの角度（ラジアン） 

barbData[0][1]= {0.523599,0.785398,1.0472} 

// 列 2: 風速／0（バーブなし）～40（4バーブ） 

barbData[0][2]= {10,20,30} 

 

// バーブをオンにするためにトレースを矢印モードに設定 

ModifyGraph arrowMarker(yData) = {barbData, 1, 10, 1, 1} 

 

// RGBカラーウェーブを作成 

Make/O/N=(3,3) barbColor 

Edit /W=(440,272,820,439) barbColor 

 

// カラーウェーブに色を保存 

barbColor[0][0]= {65535,0,0} // Red 

barbColor[0][1]= {0,65535,0} // Green 

barbColor[0][2]= {0,0,65535} // Blue 

 

// f(z) モードで色を適用 

ModifyGraph zColor(yData)={barbColor,*,*,directRGB,0} 

 

バーブデータウェーブの構築に関する詳細は、ModifyGraph コマンドの arrowMarker キーワードを参照してくだ

さい。 

「補助(Z)ウェーブからのトレースプロパティ設定」のセクションで、f(z)モードの各種カラーについて説明していま

す。 

カラーウェーブではなくカラーテーブル参照を使うことで、バーブカラーウェーブを排除できます。 

 

ボックスプロットとバイオリンプロット 

複数の測定値がすべて同じ条件を表している場合、それらの測定値がどのように分布しているかを知ることは有用で

す。 

つまり、測定値が密に集まっているか、緩やかに集まっているか、中心値の周りにグループ化されているか、外れ値

を含むより緩やかなクラスターを形成しているか、その他多くの可能性について把握することが重要です。 
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単純な点の集まりを目で理解するのは難しいため、分布を要約するプロットが役立ちます。 

ボックスプロットとバイオリンプロットは、データポイントの分布を要約する２つの方法です。 

Igor では、ボックスプロットとバイオリンプロットは特殊な種類のグラフトレースです。 

トレースの各「ポイント」はデータセット全体を表します。 

データは個々のウェーブに格納される場合があり、データセットごとに１つのウェーブが割り当てられます。 

その場合、トレースへの入力はウェーブのリストとなります。 

あるいは、各データセットは１つの 2D行列ウェーブの列となる場合もあります。 

通常の XY グラフトレースは、Yデータを含むウェーブに名前が付けられます。 

したがって、Yデータが「wave0」というウェーブにある場合、トレースも「wave0」と呼ばれます。 

しかし、ボックスプロットやバイオリンプロットは、複数のウェーブから得られたデータを表す場合があります。 

デフォルトでは、ボックスプロットまたはバイオリンプロットのトレース名は、ウェーブリストの最初のウェーブに

基づいて命名されます。 

ただし、カスタムのトレース名を指定した場合はこの限りではありません。 

ウェーブの集合の性質を説明するカスタムトレース名を選択することを推奨します。 

 

ボックスプロットとバイオリンプロットの用語 

用語を説明するために、次のコマンドを実行します： 

Make/N=10 wave0, wave1, wave2 

Make/T labels = {"Run 1", "Run 2", "Run 3"} 

Display; AppendBoxPlot/TN=trace0 wave0, wave1, wave2 vs 

labels 

 

これにより、trace0 という名前のトレースを持つボックスプロットが作成されます。 

このトレースは、wave0、wave1、wave2 という名前の３つのデータセットで構成されています。 

/TN=trace0 を省略した場合、トレースにはデフォルト名 wave0 が付けられます。 

３つの 1Dウェーブの代わりに３列の 2Dウェーブを使うことで、同じ結果を得ることができます： 

Make/N=(10,3) mat 

Make/T labels = {"Run 1", "Run 2", "Run 3"} 

Display; AppendBoxPlot/TN=trace0 mat vs labels 

 

これにより、trace0 という名前のトレースが１つあるボックスプロットが作成されます。 

このトレースは、mat[0]、mat[1]、mat[2] という名前の３つのデータセットで構成されています。 

/TN=trace0 を省略した場合、トレースにはデフォルト名 mat が付けられます。 
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ボックスプロットとバイオリンプロットの作成 

ボックスプロットを作成するには、Windows→New→Box Plot を選択します。 

バイオリンプロットを作成するには、Windows→New→Violin Plot を選択します。 

これらのダイアログでは、データセットを選択したりその他のパラメーターを設定したりできます。 

左側のリストからプロットに使うデータセットを選択し、矢印ボ

タンをクリックして右側のリストに転送します。 

初期状態ではダイアログには 1Dウェーブのみが表示され、トレ

ースで表示する各ボックスまたはバイオリンに対して１つのウェ

ーブを選択する必要があります。 

データが 2Dウェーブの場合、左側のリストの上のメニューで 

One Multicolumn Wave を選択してください。 

1Dウェーブを使っている場合、ウェーブのリストを右側のリス

トに転送した後、ウェーブを上下にドラッグして並べ替えること

ができます。 

リスト内のウェーブの順序が、トレース内のプロットの順序を決

定します。 

複数列ウェーブを使う場合、順序はウェーブ内の列によって設定

されます。 

 

Xウェーブを選択する必要がある場合もあります。 

_calculated_ を選択すると、プロットの X軸上の位置は Igor によって計算されます。 

1Dウェーブのリストの場合、プロットは 0、1、2、... の位置に配置されます。 

データセットが複数列ウェーブの列である場合、_calculated_ を選択すると、プロットはウェーブの Yスケーリン

グ（すなわち、列次元インデックスのスケーリング値）に基づいて配置されます。 

X Wave メニューには数値ウェーブとテキストウェーブの両方が含まれています。 

数値ウェーブを選択すると、各プロットを X軸上の任意の位置に配置できます。 

テキストウェーブを選択すると、カテゴリ X軸が生成されます（ヘルプ Category Plots を参照）。 

Xウェーブメニューに表示されるウェーブは、選択されたデータセットごとに１つのポイントを持つウェーブに限定

されます。 

New Box Plot または New Violin Plot ダイアログは、新しい

テキストウェーブも作成できます。 

X Wave メニューから _new text wave_ を選択すると、ダイ

アログが適切な長さの新しいテキストウェーブを生成し、プレー

スホルダーテキストで埋め、編集用にテーブルに表示するコマン

ドを生成します。 

その結果、新しいテキストウェーブを使用したカテゴリ X軸が得

られます。 

新しいトレースにカスタム名をつけるには、Trace Name チェ

ックボックスをオンにし、関連する編集ボックスに名前を入力し

ます。 

カスタム名は、1Dウェーブのリストを使う場合に特に有用で

す。 

デフォルトのトレース名は最初のデータウェーブの名前に基づい

ているため、混乱を招くためです。 

 

X軸、Y軸、および XY軸の入れ替えコントロールは、New Graph ダイアログ（「グラフの作成」のセクションを

参照）と同様に動作します。 

１つのグラフには複数のボックスプロットまたはバイオリンプロットトレースを含めることができ、両者を混在させ

ることができます。 
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別のボックスプロットまたはバイオリンプロットを追加するには、Graph→Append to Graph→Box Plot または 

Graph→Append to Graph→Violin Plot を選択します。 

 

ボックスプロット 

ボックスプロット（箱ひげ図）は、John W. Tukey によって考

案され、データポイントの分布をわかりやすく表示するために用

いられます（「ボックスプロット参考文献」のセクションを参

照）。 

ボックスプロットはいくつかの部分から構成されます： 

箱の上端と下端はデータセットの第１四分位数と第３四分位数に

位置し、箱を横切る線は中央値を表します。 

したがって、箱は分布の幅を示し、中央線は分布の中心位置を示

します。 

ウィスカー（ひげ）は、テールの長さや分布の対称性など、デー

タ分布の幅に関するより多くの情報を表します。 

デフォルトでは、Igor はウィスカーを極端なデータポイントに

描画しますが、ウィスカーの長さには８つの異なるオプションが

あります。 

ボックスの幅は意味を持ちませんが、見栄えの良い表示にするた

めに調整することができます。 

幅は分数で表すことができ、その場合、プロット領域の幅に対す

る割合となります。 

幅の指定が 1より大きい場合、それは絶対的なポイント単位の幅

と見なされます。 

 

デフォルトでは、幅は 1/(2*N) です。 

ここで N は、トレースに含まれるデータセットまたはボックスプロットの数です。 

通常、分布の中心から大きく離れた実際のデータポイントも表示されます。 

Tukey は「外れ値（outliers）」と「極端な外れ値（far outliers）」も定義しています。 

Igor では、すべてのデータポイント、外れ値と極端な外れ値のみ、または極端な外れ値のみを表示できます。 

 

ボックスプロットのフェンス 

一部のオプションでは、外れ値と極端な外れ値を定義する境界線およびウィスカーの長さを定義するために、Tukey

の「フェンス（fence）」を使います。 

Tukey はまた、25パーセンタイルと 75パーセンタイルを指す用語として「ヒンジ（hinge）」を使っています。 

内側のフェンスは次のように定義されます： 

inner fence = upper hinge + 1.5*IQR and lower hinge - 1.5*IQR 

外側のフェンスは次のように定義されます： 

outer fence = upper hinge + 3*IQR and lower hinge - 3*IQR 
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ボックスプロットのウィスカーの長さ 

以下の図は、ウィスカーの長さを定義するオプションを示しています。 

フェンスは Tukey の定義を参照するために表示されており、外れ値の処理方法（「ボックスプロットの外れ値の処

理方法」のセクションを参照）はオプション 0です： 

 

オプション 0： 最小・最大データポイント（デフォルト） 

オプション 1： 内側のフェンス 

オプション 2： 「隣接ポイント（Adjacent points）」とは、Tukey が内側のフェンス内に位置する最も極端な

データポイントと定義するもの。つまり、Tukey の定義に従うなら、外れ値ではない最も極端な

データポイント 

オプション 3： データの平均値からの１標準偏差。プラス記号付きの明るい円は平均値を示す 

オプション 4： 第 9パーセンタイルと第 91パーセンタイル 

オプション 5： 第 2パーセンタイルと第 98パーセンタイル 

オプション 6： 任意のパーセンタイル。上記では、他の選択肢と見た目を変えるため、両端を 20パーセンタイル

と 80パーセンタイルに設定 

オプション 7： 平均からの１標準偏差に任意の係数を乗じた値。上記の場合、係数は 3 

データが正規分布している場合、第 2、第 9、第 25、第 50、第 75、第 91、第 98パーセンタイルは等間隔になる

はずです。 

例では全てのデータポイントが表示されていますが、外れ値と極端な外れ値のみを表示するのが一般的です。 

データポイントは「ジッター（jitter）」処理で表示されます。 

つまり、重なり合うデータポイントは水平方向にオフセットされ、各データポイントが識別可能になります。 

ボックスの幅の分数単位でジッター量を指定することで、最大オフセットをコントロールできます。 

指定された幅がポイントを分離するのに不十分な場合、必要に応じて点が重なります。 

幅が必要以上に大きい場合、必要な分だけオフセットが適用されます。 

通常の慣行ではフェンスは示しません。 
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ボックスプロットの外れ値の処理方法 

デフォルトでは、フェンスに基づいて外れ値と極端な外れ値を定義する時に Tukeyの手法に従い、「外れ値」は内

側のフェンスの外側にあるポイント、「極端な外れ値」は外側のフェンスを越えたポイントとします。 

通常、実際には表示されませんが、ModifyBoxPlot showFences=1 コマンドを使うことで、プロットにフェンスを

含めるよう Igor に指示できます。 

外れ値は塗りつぶした円で示され、極端な外れ値は大きな塗りつぶした四角で示されます。 

Igorは、どのデータポイントが外れ値および極端な外れ値となるかをコントロールするための４つのオプションを提

供します： 

オプション 0： Tukey の定義。外れ値とは内側のフェンスを

  越えたデータポイントで、遠い外れ値とは外

  側のフェンスを越えたデータポイント 

オプション 1： ウィスカーの端点を超えるポイントはすべて

  外れ値。極端な外れ値は存在しない。このオ

  プションでは、ウィスカーは第 6パーセンタ

  イル（2%）、第 98パーセンタイル（98%）

  に設定 

  

オプション 2： 外れ値および極端な外れ値とは、平均値の標準偏差に任意の係数を掛けた値を超えるポイント。j

上記の場合、それらの因子は 1と 2。ウィスカーの長さはオプション 7に設定され、任意の係数

に平均の標準偏差を乗じた値となる。係数は 2に設定。白いダイヤは平均値 

オプション 3： 外れ値および極端な外れ値は、４つの任意のデータ値によって決定。上記の場合、それらの値は 

-2、-1.5、1、2.6 

 

ノッチ付きボックスプロット 

ノッチ付きボックスプロットは、通常表示される各種パーセンタイルに

加え、中央値の 95% 信頼区間を示します。 

ノッチは中央値 ±1.57×四分位範囲/√n の位置にあります。 

ここで n はボックスプロットで表されるデータセットのデータポイント

の数です。 

ノッチが重ならない場合、２つのボックスプロットが大きく異なる中央

値を持つ確率は高くなります。 

ボックスプロットのトレースを右クリックし、Modify Box Plot を選択

すると、ノッチ付きボックスプロットを作成できます。 

Modify Box Plot ダイアログの General タブで、Notched チェックボ

ックスをオンにします。 
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ボックスプロットの外観オプション 

ボックスプロットの外観を変更するには、Graph メニューから 

Modify Box Plot を選択するか、ボックスプロットのトレースを

右クリックし、コンテキストメニューから Modify Box Plot を選

択します。 

線の色、太さ、破線のスタイルを変更できます。 

これらの設定は、ボックス、ウィスカー、中央線、ウィスカーの

キャップといった各コンポーネントごとに個別に行えます。 

フェンスは付随的な詳細と考えています。 

表示をより理解しやすくするためにフェンスを表示することは可

能ですが、パブリケーション目的で使われた例はこれまでのとこ

ろ確認できていません。 

 

また、フェンスの線は変更できません。 

ウィスカーのキャップの幅をコントロールできます。 

キャップを省略する場合（デフォルト）、幅をゼロに設定してく

ださい。 

分数幅は、キャップのサイズをボックス幅の分数として設定しま

す。 

これは、グラフのサイズを変更した時にキャップの幅を一定に保

つのに役立ちます。 
 

1より大きい幅の指定は、ポイント単位での絶対的な幅として扱われます。 

以下のプロットはスペース節約のため水平方向に描画されています。 

この効果を得るには、Graph メニューから Modify Graph を選択し、Swap XY チェックボックスをオンにしま

す。 

あるいは、New Box Plot または Append Box Plot ダイアログで Swap X Y Axes チェックボックスをオンにする

と、入れ替えを１つのボックスプロットトレースにのみ適用できます。 

ボックスは色で塗りつぶすことができます。 

ボックスの塗りつぶし色はマーカーより先に描画されるため、マーカーの設定内容にかかわらず塗りつぶし色に上書

きされることはありません。 

 

外れ値でないデータ、外れ値、および極端な外れ値に対して、異なるマーカーを選択できます。 

上のプロットでは、通常のデータポイントと外れ値は中空の円マーカーで描画され、外れ値は通常のデータポイント

よりも大きく表示されて強調されています。 

極端な外れ値は塗りつぶされたマーカーで表示されます。 

中空マーカーを使い、マーカーの塗りつぶし色を選択することで、いくつかの特殊効果を実現できます。 

例えば、次のプロットでは、中空の円マーカーが通常のデータポイントに使われ、塗りつぶし色が有効化され白色に

設定されています。 
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箱、中央値、ウィスカーを描く線はマーカーの上に配置されてお

り、マーカーが線を隠さないようにしています。 

マーカーを前面に配置したい場合もあるでしょう。 

このデータセットでは、それによって線が隠れてしまう可能性が

あります。 

この効果を実現するには、Markers タブで Draw Data Points on 

Top チェックボックスをオンにします。 

平均マーカーと中央値マーカーの描画を個別にコントロールでき

ます。 

 

 

上記の通り、すべての生データを表示する選択も可能です。 

または、生データポイントを一切表示せず、外れ値と極端な外れ値のみを表示する選択、あるいは極端な外れ値のみ

を表示する選択も可能です。 

次のプロットは外れ値と極端な外れ値のみを表示しています。 

 

上のプロットではデータポイントにジッターを適用しています。 

つまり、マーカーが重なる場合、横方向のオフセットを加えることで全てのマーカーを確認できるようにしていま

す。 

ジッターの幅を指定することで、横方向の最大オフセットを設定できます。 

オフセットが小さすぎてマーカーを完全に分離できない場合、マーカーはある程度重なります。 

特定のマーカーにおいてオフセットが必要ない場合、そのマーカーはオフセットされません。 

ボックスプロットにおいて、データポイントを「ラグプロット」として表示する場合があります。 

つまり、各データポイントを細い線で表します。 

これはデータポイントが多すぎない限り、すべてのデータポイントを見えるようにする別の方法です。 

これを行うには、線マーカーを使用し、ジッターをゼロに設定します。 

次のプロットでは、通常のポイント、外れ値、および極端な外れ値のマーカーは、サイズが 8に設定された同じ垂直

線マーカー（マーカー10）です。 

キャップはゼロに設定され、極端なデータポイントはキャップのように見えます。 

 

透明性のある大きなマーカーも、データ密度を表現するのに役立ちます。 

このプロットでは、実線の丸印（番号 19）を使い、色は青、不透明度は 0.1に設定されています。 

ボックスの塗りつぶし色は無効化しています。 

背景が透明マーカーを通して見え、色に影響を与えるためです。 
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データセットやデータポイントの数が膨大になることもあります。 

よりコンパクトな表示を実現する別の見方を次に示します： 

 

ウィスカー法は係数が 2に設定されている Mean ± f*SD に設定されているため、ウィスカーは平均値を中心に 2

標準偏差の範囲を示します。 

外れ値の表示方法はウィスカーに設定されているため、ウィスカーの端点を超えるデータポイントのみが表示されま

す。 

これによりプロット上のデータポイントの総数が制限されます。 

データセットが多数存在するため、ボックスはかなり狭く、ソリッドなボックスを作るために塗りつぶされていま

す。 

見づらい中央線ではなく、中央線は白で塗りつぶされた円形のマ

ーカーで表示されます。 

ボックスプロットの輪郭が白のマーカー塗りつぶしの上に表示さ

れないようにするため、Modify Box Plot ダイアログの Markers 

タブで Draw Median Marker On Top チェックボックスがオン

になっています。 

最後に、平均値は水平バーのマーカーとして表示されています。 

マーカーのサイズは、中央値の円マーカーの外側に表示されるよ

うに十分に大きく設定されています。 
 

 

ボックスプロットの参考文献 

Tukey, John W., Exploratory Data Analysis, Addison-Wesley Publishing Company, 1977. 
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バイオリンプロット 

バイオリンプロット（ビーンプロットとも呼ばれる）は、データの分布を要約する方法です。 

バイオリンプロットは、カーネル密度推定（KDE）を用いてデータセットの分布を示します。 

KDE は、データポイントごとに１つのカーネル関数を合計することで、基礎となるデータ分布の滑らかな推定値を

生成します。 

合計の曲線はその後、面積が 1.0となるよう正規化され、これによりデータセットの確率分布関数の推定値となりま

す。 

ガウス分布から得られた５つのポイントがあると仮定します。 

例えば、ここに黒い点で表されているようなポイントです。 

 

各ポイントに対してガウス曲線を生成し（赤い曲線）、それらを合計して面積が 1になるよう正規化します（黒い曲

線）。 

このプロットでは、赤色の曲線に対して標準偏差を 0.5と任意に設定しています。 

これは KDE曲線やバイオリンプロットを計算する時の「バンド幅」と呼ばれます。 

これで、データポイントが抽出された基礎分布の可能な表現を与える滑らかな曲線が得られます。 

おそらく使ったカーネルの帯域幅が小さすぎる時には、ポイント数が少ないことによって正当化できないかもしれま

せん。 

カーネル関数の選択（この例ではガウス関数）とカーネルの幅は、ある程度任意です。 

ガウスカーネルはある意味で「滑らか」で、ほとんどのデータがガウス分布に従うという私たちの偏見を反映してい

ます。 

他の分布も考えられるでしょう。 

StatsKDE コマンドを使ってデータセットの KDE を自身で計算すること

は可能ですが、そこからバイオリンプロットを作成するのは非常に手間が

かかります。 

バイオリンプロットのトレースを作成する時、「ボックスプロットとバイ

オリンプロットの作成」のセクションで説明している手順を実行すると、

Igor がこの作業の多くを自動的に行います。 

バイオリンプロットでは、曲線は通常垂直にプロットされ、中心線で左右

対称に反転されます。 

これにより、バイオリンやインゲン豆のさやに似た形状のプロットが得ら

れます。 

各粒はプロット上の隆起として表されます。 

右は、上記の５つのポイントを示した Igor によるバイオリンプロットで

す。 

生データポイントが表示され、黒色で描画するよう修正されています。  

このプロットでは、曲線の幅は相対的な意味合いを除いて意味を持ちません。 

中心線は推定確率密度がゼロであることを示します。 
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トレースに含まれる唯一のデータセットであり、カテゴリプロットではないため、X軸のゼロ位置に配置されていま

す。 

以下の図解のために、２つの疑似データセットを作成します： 

Make/N=(50,3) run1    // 50 ポイント/データセット、3つのデータセット 

Make/N=(50,3) run2    // 50 ポイントを持つ別の３つのデータセット 

run1 = gnoise(q+1)    // 列番号に基づいた標準偏差を持つ Gaussianデータ 

run2 = gnoise(1) + q    // 列番号に基づいた一定の幅と位置を持つ Gaussianデータ 

Make/N=3/T categories="dataset "+num2str(p+1) // カテゴリバイオリンプロット作るテキストウェーブ 

この時点で、Windows→New Violin Plot を選択し、One 

Multicolumn Wave を選択し、データとして run1を選択し、X

ウェーブとしてカテゴリを選択します。 

その結果、以下のコマンドが生成されます： 

Display;AppendViolinPlot run1 vs categories 

 

Graph→Append to Graph→Violin Plot を選択し、One 

Multicolumn Wave を選択し、データとして run2を選択し、X

ウェーブとしてカテゴリを選択します。 

その結果、以下のコマンドが生成されます： 

AppendViolinPlot run2 vs categories 

 

結果のグラフは右のようになります。 

 

バイオリンプロットの外観オプション 

バイオリンプロットの外観を変更するには、Graph→Modify Violin Plot を選択するか、右クリックして Modify 

Violin Plot を選択します。 

Igor のバイオリンプロットには６種類のカーネル形状が選択可能です。 

デフォルトはガウス分布であり、他の形状が頻繁に使われるとは想定していません。 
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最適な帯域幅を自動的に推定する方法は３つあります。 

自動の帯域幅の結果が気に入らない場合は、データセットごとに

個別の帯域幅を設定できます。 

自動推定は Gaussian カーネルを前提としています。 

バイオリンプロットの各プロットは、ボックスプロットのボック

ス幅に相当する水平方向の領域を占有します。 

このボックス幅はボックスプロットと同様の方法で設定できま

す。 

小数指定はプロット領域の割合を幅として設定し、１より大きい

値は絶対的なポイント単位のサイズを指定します。 
 

X軸がカテゴリ軸の場合、Igor はボックス幅を設定し、ユーザーが選択した設定を上書きします。 

Igor が複数のデータセットを含むバイオリンプロットを作成する場合、すべての曲線は KDE 曲線全体の中で最大

のピークに対して正規化されるため、バイオリンプロットのうち１つだけがボックス幅全体を占めます。 

上記の図からわかるように、Run1 トレースの３番目のデータセット（各カテゴリの左側の図）は分布が広いデータ

セットを表していて、面積が 1になるためには振幅が小さくなければならないことを意味します。 

他のカテゴリの短くて太い分布と比較してください。 

複数のバイオリンプロットがある場合（この例では２つのバイオリントレースがあります：１つは run1、もう１つ

は run2）、デフォルトでは各トレース内で最も幅の広いプロットがボックス全体を埋めます。 

２つのトレースは別々に正規化されます。 

両方のトレースのすべてのプロットで同じ正規化を使いたい場合

は、すべての曲線の相対振幅が同じ相対値を表すように、正規化

を自分で設定できます。 

これは、Modify Violin Plot ダイアログの General タブにある 

Distribution Max 設定を使って行います。 

編集ボックスの横に、Igorによって計算された値が表示されま

す。 

 

マーカー付きで生データを表示するのは一般的です。 

デフォルトでは、生のデータポイントは、通常のトレースにおけるデフォルトマーカーの半分のサイズで描画された

中空の円を使って表示されます。 

生のデータポイント用のマーカーを選択でき、必要に応じて平均値と中央値用のマーカーも追加できます。 

バイオリンプロットは外れ値を区別しません。 

データポイントマーカーにジッターを適用することで、それらが重ならないようにできます。 

生データのラグプロットを作るには、適切な線マーカーを使い、ジッターを 0に設定してください。 

ほとんどのバイオリンプロットは縦方向にプロットされるため、水平線マーカーが適切です。 

KDE 曲線間の空間は色で塗りつぶすことができます。 

塗りつぶし色はマーカーの後ろに描画されるため、マーカーの色、マーカーの線の色、マーカーの塗りつぶし色を用

いて特殊効果を実現できます。 

上記のプロットを、塗りつぶし色と中が白の丸いマーカーで作成したものが以下です： 

 



24 

 

そしてこれがラグプロットです： 

 

一部の曲線が少し切り詰められているように見えることに気づくかもしれません。 

右側のトレースにあるデータセット 3のプロットにおいて、その傾向が特に顕著です。 

デフォルトでは、Igor は KDE 曲線を最後のデータポイントから 1バンド幅分外側にプロットします。 

この場合、曲線をもう少し延長した方が良いかもしれません。 

そのために、トレースを右クリックし、Modify Violin Plot を選

択します。 

General タブで Curve Extension 編集ボックスを見つけ、より

適切な延長量を入力します。 

単位はカーネル帯域幅です。 

2に設定すると次のようになります： 
 

 

 

非対称バイオリンプロット 

標準的なバイオリンプロットの一般的なバリエーションとして、バイオリンの半分のみを使う方法があります。 

これは通常、２つの条件または２つのラン（実行）を比較するために行われます。 

一方の条件が左半分を提供し、もう一方の条件が右半分を提供します。 

上記のプロットを非対称プロットにしてみます。 
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最初のステップは、プロット内のトレースのいずれかを右クリック

し、コンテキストメニューから Modify Violin Plot を選択することで

す。 

例えば Run1 トレースなど、左半分に使うトレースを選択します。 

General タブで、Plot Side メニューから Left Side を選択します。 

Run2 を選択し、Plot Side メニューで Right Side を選択します。  

Do It をクリックすると、次のようなプロットが表示されます： 

 

X軸がカテゴリ軸であるため、各プロットはカテゴリ内でそれぞれの位置を占めます。 

それらをまとめるには、Run1 トレースをダブルクリックして 

Modify Trace Appearance ダイアログを表示します。 

トレースリストの最初のトレースが選択されていることを確認してく

ださい。 

Grouping メニューで Keep With Next を選択します。  

また、見た目の理由からグラフウィンドウを狭くすると次のようになります： 

 

X軸が数値軸の場合、Grouping モードの設定という最後のステップは不要です。 

２つのバイオリンプロットトレースは、Xウェーブで設定された数値、または _calculated_ を選択した場合の 0、

1、2などの位置でプロットを描画します。 
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最後に、色で塗りつぶされた領域全体を線で囲むとプロットの見栄え

が良くなると判断する場合があります。 

Modify Violin Plot ダイアログの General タブで、Close Outline 

チェックボックスをオンにします： 

 

 

 

バイオリンプロットの参考文献 

Wand M.P. and Jones M.C. (1995) Monographs on Statistics and Applied Probability, London: Chapman 

and Hall 

Bowman, A.W., and Azzalini, A. (1997), Applied Smoothing Techniques for Data Analysis, London: Oxford 

University Press. 

 

ボックスプロットとバイオリンプロットを異なる見た目にする 

トレース内のボックスやバイオリンのどちらかを、対応するデータセットをトレース内の他のデータセットと区別す

るために異なる外観にしたい場合があります。 

Modify Box Plot と Modify Violin Plot ダイアログでは、トレースから１つのデータセットを選択できるようにする

ことで、この機能をサポートしています。 

右の画面は、３つのウェーブのリストで作成されたボックスプロット

トレースを含む Modify Box Plot ダイアログを示しています。 

wave0 トレースの三角アイコンをクリックすると、各ウェーブに対

応する３つのデータセットのリストが表示されます。 

 

最上位の wave0 項目が選択されている場合、ダイアログで行った変更はトレース内の全データセットに適用されま

す。 

ここでは２番目のデータセットを選択しているため、ダイアログで行った変更はデータセットのみに適用され、結果

としてボックスプロットにおける２番目のボックスにのみ反映されます。 
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これらのグラフは、２番目のデータセットのみを薄い青色にボックス塗りつぶし色を設定する前と後の状態を示して

います： 

 

  

これらの設定を行う順序は重要です。 

全体設定を変更すると、個々のデータセットに対応する値はすべて全体設定の値にリセットされます。 

上記のボックスプロットを全体を薄い青色、２番目のデータセットを薄い緑色で作成するには、まずトレース全体に

薄い青色を設定し、その後 2番目のデータセットのみに薄い緑色を設定する必要があります。 

これらの変更の間でダイアログを閉じる必要はありません。 

 

各データポイントを異なる見た目にする 

１つのデータセット内のデータポイントが変わったソースから得られた場合や、異なる条件を表す場合があり、それ

をグラフ上で示したいことがあります。 

補助ウェーブを使うと、各データポイントのマーカーの色、サイズ、またはスタイルを設定できます。 

これらの設定のコントロールは、Modify Box Plot ダイアログの Markers タブに表示されます。 

 

例えば、右のテーブルは最初の列にフェイ

クのデータセットを示し、対応する３列の

ウェーブで各データポイントのマーカー色

を指定しています。 

 

そのデータセットでボックスプロットを作

成し、ウェーブの BoxPlotColors を選択し

てデータポイントのマーカー色を設定しま

した。 

結果は右のボックスプロットになります。 
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この図でのカラーウェーブは、カラーウェーブエ

ディタパッケージを使って作成されました。 

このパッケージは、Data→Packages→Color 

Wave Editor を選択することでアクセスできま

す。 

同様に、各データポイントのマーカーを異なるサ

イズまたは異なるマーカースタイルに設定できま

す。 

これには、各データポイントごとにサイズまたは

マーカー番号を指定する 1Dウェーブを使いま

す。 

 

 

 

 

マーカーのサイズは 0から 200の範囲で設定できます。 

マーカースタイルと対応するマーカー番号の一覧については、「マーカー」のセクションを参照してください。 

これらのウェーブによって設定されたマーカーの色、サイズ、スタイルは、他の設定をすべて上書きします。 

例えば、ボックスプロットの外れ値用に特定のマーカーを選択した場合でも、外れ値データポイントにマーカーウェ

ーブを通じてマーカーが設定されている場合、そのマーカーはウェーブから取得されます。 

マーカーの色、マーカーのサイズ、マーカーのスタイルの各ウェーブは、データセットのウェーブと同じ行数を持つ

必要はありません。 

余分な行がある場合、余分な行は無視されます。 

行数が少なすぎる場合、余分なデータポイントは通常の色、サイズ、スタイル設定から色、サイズ、スタイルを取得

します。 

 

ボックスプロットとバイオリンプロットを組み合わせる 

ボックスプロットの問題点の一つは、データの真の分布を隠してしまうことです。 

データが二峰性であっても、表示されるのは中央値線とひげを持つ箱ひげ図のみです。 

しかし、バイオリンプロットにはボックスプロットに含まれる統計情報が欠けています。 

一般的な解決策は両者を組み合わせることです。 

そこで、バイオリンプロットの中央にボックスプロットを配置します。 

Igorでこれを行うには、まず Windows→New→New Violin Plot 

を使ってバイオリンプロットを作成します。 

バイオリンプロットの例にある Run1 データセットでこれを実行

します。 
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塗りつぶし色を選択し、データポイントは表示していません。 

 

Graph→Append To Graph→Box Plot を選択してボックスプロ

ットを追加します。 

カテゴリ X軸を使っているため、プロットは並べて表示されま

す。 

 

バイオリンプロットのトレースをダブルクリックし、グループ化

モードとして Keep With Next を選択します： 

 

見た目を良くするには、ボックスプロットを細くし、箱を対照的

な色で塗りつぶすのが良いでしょう。 

ここではボックスの幅を 0.1に設定し、ボックスを白で塗りつぶ

すように選択しました。 

データポイントは表示しませんが、表示したい場合は、塗りつぶ

しがデータポイントを隠さないよう、ボックスプロットトレース

を使用して表示するのが最適です。 
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